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Tutorial

Lid Driven Cavity

Flow Involving Isothermal and Incompressible Fluid
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The geometry Is a two-dimensional square domain which
all the boundaries of the square are walls.

The top wall moves on the x-direction at a speed of 1 m/s
while the other three are stationary. U, =1m/s

e

A

d=0.1m
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Inside the $FOAM_RUN directory you will find the
cavity case.

On the terminal enter inside the cavity case
>> cd $SFOAM_RUN/cavity

Create the mesh
>> hlockMesh

Run the solver
>> |coFoam
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We can check the convergence of the simulation using the
utility gnuplot to draw the residuals of pressure and

velocity profiles.

1 set logscale y

2 set title "Residuals”

3 set ylabel 'Residual’

4 set xlabel 'Iteration'

5 plot "< cat log_simulation | grep 'Solving for Ux' | cut -d' ' -f9" title 'Ux' with lines,)\

6 "< cat log_simulation | grep 'Solving for Uy' | cut -d' ' -f9" title 'Uy' with lines,)

7 "< cat log_simulation | grep 'Solving for p' | cut -d' ' -f9 | sed -n 'p;N' | tr -d ','" title 'p' with lines
8 pause 1

Brereaﬂ

Save file with name Residuals.
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The command to see the graphic is
>> gnuplot Residuals
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View results
>> touch cavity.foam

>> paraview cavity.foam
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Use Glyph option to plot velocity field
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Plot Over Line the velocity field in the middle of the
channel along y direction, P1(0,05;0;0,005) and
P2(0,05;0,1;0,005).

n IPC/I3N — Institute for Polymers and Composites University of Minho
Department of Polymer Engineering Portugal

Il\


http://www.uminho.pt/default.aspx
http://www.uminho.pt/default.aspx

FOAM@PT, Guimaraes, Portugal, July 2015

Use Calculator to plot real pressure (assume density
equal 1000 kg/m?)

Pressure (Pa)
4,849e+03
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Sources
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Export Scenes
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Tutorial

Goldschmidt

Fluid Flow Through a Packed Bed of Particles
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OpenFOAM includes a transient solver for the coupled
transport of a single kinematic particle cloud including the
effect of the particulate volume fraction on the continuous
phase, suitable for dense particle flow simulation.

The solver name 1s DPMFoam.
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A Dbed of particles (24750) 1is
initially setup In a rectangular
geometry.

For the gas phase a prescribed
Influx condition is applied at the
bottom, no-slip boundary
conditions are applied at the side
walls and a prescribed pressure
condition Is applied at the top of the
bed.
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Inside the $FOAM_RUN directory you will find the
Goldschmidt case with the results already computed due
to the large time necessary to run this tutorial.

On the terminal enter inside the Goldschmidt case
>> cd $FOAM_RUN/Goldschmidt

And open paraview to visualize the results
>> touch goldschmidt.foam
>> paraview goldschmidt.foam
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First, to obtain better
visualization of the particulate
field we can load the POINT .. .. .. coe s e oo e

Create Custom Filter...

- - 2 & B g . > =
Sprite plugin. B = o e e | o
90T ® O ¢ G o0 pr o
In the Tools menu choose the |z e Bei7
Manage Plugins... submenu
and there we can find the S

PointSprite Plugin.
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~—Local Plugins

u Name |Pr|t]|pt::rt3,.r
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Next, in the Filter menu = o me

choose the Alphabetical | o

submenu and click on the =

Extract Block option.\ =

Choose the internalMesh

field In the left side

Properties panel and press

Apply [ -+ apply H Re Dpem[ﬁ%mt ][ 2 ‘
\[:P operties (ExtractBlock1) @| &I e

|EBI kl d | —
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Repeat ~ the  same M) o [ mome | 7
procedure but now choose e T
the Lagrangian Particles < Block ndices

feld.

Now we can see separately
the behavior of the
continuous  (gas) and
discrete (particles) fields.
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With the PointSprite option in the
representation bar and the Max
Pixel size of the PointSprite menu
try to reproduce the image on the
right.
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Tutorial

Propeller

Analysis of Flow around a Ship Propeller
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OpenFOAM includes the Arbitrary Mesh Interface
technigue (AMI) for non-conformal patches.

AMI Is a technique that allows simulation across
disconnected, but adjacent, mesh domains. The domains
can be stationary or move relative to one another.

The sliding interface capability has been tested on
engineering geometries, including a propeller.
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Flow was simulated using the pimpleDyMFoam solver.

Transient solver for incompressible flow of Newtonian
fluids on a moving mesh using the PIMPLE (merged

PISO-SIMPLE) algorithm.
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The propeller geometry is represented in the figure.

Inlet fixedValue Outlet inletOutlet
Velocity — 5 m/s Velocity
Inlet zeroGradient Outlet fixedValue
Pressure Pressure — 0 Pa
\ ' .
2\ outerCylinder

A "5 fixedValue
propeller | Velocity — 0 m/s

movingWallVelocity outerCylinder

zeroGradient
Pressure
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Inside the $FOAM_RUN directory you will find the
Propeller case with the results already computed due to the

large time necessary to run this tutorial.

On the terminal enter inside the Propeller case
>> cd $FOAM_RUN/Propeller

And open paraview to visualize the results
>> touch propeller.foam
>> paraview propeller.foam
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In Paraview try to animate

Styling

the propeller velocity field
and export the video with wowidh 3
streamlines.

First, open only the
InternalMesh  and  press

apply.

Change the Opacity value to
0.1.
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Then, open again the same case and choose only the
propeller patches.

[%|Mesh Regions Fi,
fixedWalls

simetry
frontAndBack

outerCylinder
| propellerTip
| propellerSteml
| propellerStem?2
| propellerStem3
AMI1
o al

Now, have sure that the two cases are selected and
advance one time step.

B builtin:

@F!m
@ - d.foam K <1 > > Pl 5 Time |1 F&of101
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Choose the streamTracer option.

/

90 DRVOSL20 % Mo w o+

Press the Center on Bounds button. Finally, press apply.

Seed Type Point Source

| Show Point Center on Bounds
Point | 0 -0.3000000044| | O
Number of Points | 100

Radius 0.0600000023841858

We should obtain an image similar to the one below,
coloring by the velocity field.
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File | Edit View Sources Filters
' Open... Ctrl+0
Recent Files 3

© Save Data... Ctrl+s | '@:

To finalize we will export a puisae
video with the movement of  Sove Srsesho.. =
the propeller. o

& Connect...

=)

4 Disconnect
Exit Ctrl+Q

For that In the File menu

Animation Settings Dialog

click on Save Animation and

Frame Rate (fps) | 5.00

Setup Frame Rate to 5 and No. of Frames / timestep |1

Number Of Frames
f = I I I = k S Resolution (pixels) 1439 848 (8]
I n a y C I C O n ave Timestep range 0 100

Stereo Mode (if applicable) | No Stereo

Animation. B Comprsson

IPC/I3N — Institute for Polymers and Composites University of Minho
Department of Polymer Engineering Portugal

Il\


http://www.uminho.pt/default.aspx
http://www.uminho.pt/default.aspx

FOAM@PT, Guimaraes, Portugal, July 2015

Tutorial

DamBreak3D

Analysis of River Flow around a Obstacle
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Flow was simulated using the interDyMFoam solver.

Solver for 2 incompressible, isothermal Immiscible
fluids using a VOF (volume of fluid) phase-fraction
based interface capturing approach, with optional mesh
motion and mesh topology changes including adaptive re-
meshing.

IPC/I3N — Institute for Polymers and Composites University of Minho
Department of Polymer Engineering Portugal

II\


http://www.uminho.pt/default.aspx
http://www.uminho.pt/default.aspx

FOAM@PT, Guimaraes, Portugal, July 2015

The damBreak geometry is represented in the figure.

— Top boundary is free
to the atmosphere so
needs to permit both
outflow and inflow
according to the
internal flow.

Total Pressure

PressurelnletOutlet\Ve

locity
Walls velocity - 0 m/s /
Pressure — fixed flux
pressure
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Inside the $FOAM_RUN directory you will find the
DamBreak 3D case with the results already computed due
to the large time necessary to run this tutorial.

On the terminal enter inside the DamBreak3D case
>> cd $FOAM_RUN/DamBreak3D

And open paraview to visualize the results
>> touch dambreak3D.foam
>> paraview dambreak3D.foam
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In Paraview try to animate the water fall and export the
respective video.

First, select the internal mesh and atmosphere patch and
choose Opacity to 0.3.

Choose the Threshold option.

HR-AE il
! i T -

= Properties (Threshold1)

And apply the following values. ... ..

Use Continuous Cell Range

= Display (UnstructuredGridRepresentati || (& || &

Representation Surface
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Next, apply the Extract Surface filter and the Smooth
filter with Number of Convergence of 500.

Finally, color the surface with Solid Color and edit the
color choosing a light blue color.

Properties
T O T
[ h ... {use Esc to clear text) ]
[ = Properties (Smoothl) =
Nfumber [500
Conven gence [[—— (o
[ = Display (GeometryRepresentation) L
Representation [Surface |v_
Coloring
| @ Solid Color [ [-]
[ i Show H s Edit H “ Rescale l

Scalar Coloring

[%| Map Scalars
(%] Interpolate Scalars Before Mapping

Basic colors

NN
HEEEEENC)
EEEEEEEC)
C L1 0 0 1 4 I
HEEEEOE)

Custom colors

UO0Oooodd
U0

[ Add to Custom Colors l
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We should obtain

To finalize we will export a video with the movement of
the water.
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Tutorial

motorBike

Analysis of Flow around a Motor Bike
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For this tutorial we will look at the simulation of the flow
around a motorbike model.

Flow was simulated using the pisoFoam solver.

Transient solver for incompressible flow. Turbulence
modeling Is generic, I.e. laminar, RAS or LES.
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The motorBike geometry is represented in the figure.

Inlet fixedValue Outlet inletOutlet

Velocity — 20 m/s Velocity

Inlet zeroGradient Outlet fixedValue

Pressure Pressure — 0 Pa
motorBike

fixedValue
Velocity — 0 m/s Front, Back,

Upper and Lower

moto(; E;E?ent walls are of type
Zero symmetryPlane
Pressure
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Inside the $FOAM_RUN directory you will find the
MotorBike case with the results already computed due to
the large time necessary to run this tutorial.

On the terminal enter inside the MotorBike case
>> cd motorBike

And open paraview to visualize the results
>> touch motorbike.foam
>> paraview motorbike.foam
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Properties | Information |
Properties =[x

In Paraview try to plot the
streamlines that were exported — ooioncomon
from the computations and are e T
saved on the postProcessing

Include Sets Groups Only

fO I d e r Include Zones Patch Names
| ]

®| Interpolate volFields Extrapolate Patches

Update GUI

First in the Paraview Properties —

painel select all Mesh parts. m

metry

-gro
- pa

E.{

P
up
atch
3 —patch
inlet - patch
outlet - patch
lowerwall - patch
upperwall - patch
motorBike_frt-fairing:001%1 - patch

cr—h
""T:—r

C
a

Press Apply to obtain all the
mesh and patches.
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N eXt’ aS i n the G O I dsch m i dt = F"r’t}pE-l't.iEE (ExtractBlockl)
tutorial select the Extract block /£ e
filter.

- [| unzoned
- =[] internalMesh
- [%] patches

|| front

-] back

= inlet

i | outlet

- (%] lowerwall
| upperwall

Unselect the iInternalMesh and
the front, back, Inlet, outlet and oweintinsecr

= Display (GeometryRepresentation)

upperwall patCheS' Representation | gyrface -

Press Apply.
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Then, apply several Clips to & POESELO®B
reduce the geometry. N {

@ ) motorBikeLES.OpenFOAM
@ ExtractBlockl

We should obtain one 1mage
similar to the one below.
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Finally, open the streamline file for the last simulation
time: postProcessing/sets/streamLines/0.7

And select velocity field to be seen. The result should be

U Magnitude
234

N
o

o

Q
mluuhuuuuhn
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Thank you for your attention!
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